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General Information

This version of Postage $aver has been updated to take into account all changes in postal 
requirements through October, 1997.

Postage $aver sorts one or more data files according to U.S. postal service (USPS) requirements for 
standard (A) bulk mail or first class automated letter mail. Postage $aver produces a complete report 
showing the composition of all mail packages and mail sacks and the piece counts and postage totals 
necessary for completing post office bulk mailing statements. Postage $aver can also create a sorting file 
that lets you sort your mailing list by sack and package, and provides postal endorsement lines for 
printing on address labels or envelopes. Postage $aver also prints barcoded sack and tray labels, soon to 
be required of all mailers. And, it prints the optional USPS Qualification Report to help speed your mail 
through the acceptance process.

A companion product, Secret Barcoder Ring, creates correct postal barcodes for use on your mailing 
labels and envelopes. Secret Barcoder Ring and a barcode printer font are provided at no extra cost to 
registered users of Postage $aver.

Postage $aver automatically rejects and lists any zip codes that are not in proper five-digit or nine-digit 
form, or which are not on the USPS chart of valid three-digit zip code areas.

Postage $aver comes in two versions: 
Postage $aver Lite, for basic presorting, and, 
Postage $aver Pro, which also sorts mail to take advantage of barcoding discounts. 

This shareware version of Postage $aver is a full-featured version of Postage $aver Lite. It can be 
upgraded automatically to Postage $aver Pro by entering an appropriate registration number, which will 
be sent to you when your register.

If you do not anticipate barcoding your mail, save money by choosing Postage $aver Lite when you 
register.    Youll still receive all updates to stay in compliance with postal sorting requirements, and full 
tech support!

Note: Throughout this help file, there will be references to "Standard (A) bulk mail". This is a new term 
that the postal service has adopted to replace what used to be called "third-class bulk mail."

What Kind of Mail Can Postage $aver Prepare?

Postage $aver is designed to sort mail that:

 is classified as standard (A) (formerly 3rd class) bulk mail and fits the "letter" or "flat" mail categories, or,
 is classified as first-class mail, is barcoded, and fits the "letter" category, and,
 is not mailed at carrier route or walk sequence rates

Postage $aver for Windows can sort a maximum of 16,000 addresses at one time, from as many as 50 
different files.

Postage $aver is available in two versions: Postage $aver Lite and Postage $aver Pro.    Postage $aver 
Lite prepares mail for nonautomation bulk rates. This shareware version is a fully-functional copy of 
Postage $aver Lite. To sort mail to earn barcoding discounts, you need Postage $aver Pro. You also need 
Postage $aver Pro if your mail is heavy enough that you must use "per pound" postage rates.

We can also provide special Postage $aver files for mail that fits "machinable parcel" or "irregular parcel" 



mail categories. Please contact us for pricing if you regularly send such pieces by standard (A) bulk mail 
and would like to use Postage $aver to sort these mailings.



Mail Type Settings

These settings determine how your mailing list is sorted and how the postage is calculated. They must be 
set correctly for your mail to be accepted by the post office.

Select Type of Mailing: 

These buttons determine how your mail will be sorted.    Each mail classification uses a different sorting 
scheme. Choose the one that matches the way you will be preparing your mail.

Nonautomation - Std A: Standard (A) letters or flats that do not contain barcodes. This type of bulk mail 
is the simplest to prepare, but earns the smallest postage discount. See M610(2.0), Domestic Mail 
Manual.

Upgradable - Std A: Standard (A) letters (not flats) that do not contain barcodes, but meet automation 
requirements in all other ways.    The post office will add barcodes to these pieces. You don't save any 
more postage than you would with nonautomation, but your mail may move faster. See M610(4.0), 
Domestic Mail Manual.

Automation - Std A: (Requires upgrade to Postage $aver Pro) Standard (A) letters or flats that meet 
USPS requirements for automated processing. All pieces, as well as tray and sack labels, must be 
properly barcoded. This classification requires the most preparation, but earns the best discounts. 
(Postage $aver produces barcoded tray and sack labels automatically.    Our companion product, Secret 
Barcoder Ring, produces correct address barcodes, and is provided at no extra charge to registered 
users of Postage $aver.) See M810 (letters) or M820 (flats), Domestic Mail Manual.

Automation - First Class: (Requires upgrade to Postage $aver Pro) First-class letters or flats that meet 
USPS requirements for automated processing. Faster processing than standard A, but more expensive. 
Particularly useful for postcards, which earn a special discount rate. See M810, Domestic Mail Manual.

Rate Category: 

These buttons determine which rates will be used to compute the amounts for your postage statement. 

For standard (A) mail, most mailers use "regular" rates. However, many non-profit organizations are 
eligible to use lower non-profit rates. You must apply and be approved by the USPS before using 
nonprofit rates. Ask for USPS Form 3624 to apply for permission to use nonprofit rates. 

For first-class mail, there is no nonprofit discount. The rate category is determined by whether or not the 
mail meets the USPS definition of a postcard. If you are mailing a card that is rectangular, no less than 3 
1/2" high by 5" long by 0.007" thick, and no more than 4 1/4" high by 6" long by 0.016" thick, then click 
"Card" to use the lower postcard rates. Otherwise, if you are mailing first-class mail, you must use the 
"Regular" category.

Note: Nonprofit mailers were, for a short time, allowed to sort mail differently from regular mailers.    Now, 
mail is sorted the same way regardless of whether the mailer is using nonprofit or regular rates.

Letter/Flat: 

These buttons determine how to sort your mail and what rates to use when computing your postage 
costs. Whether a piece of mail is a letter or a flat depends only on the size of the mail piece, not on its 



content. Size categories are as follows (note that references to "longer" and "shorter" sides are based 
strictly on their measurements, regardless of which way the address label is read.):

Letter:
Shorter side: minimum 3 1/2"; maximum 6 1/8"
Longer side: minimum 5"; maximum 11 1/2"
Thickness: minimum .007"' maximum 1/4"

Flat:
Shorter side: maximum 12"
Longer side: maximum 15"
Thickness: maximum 3/4"

Mail that is larger than flat-sized in any dimension may be mailed at standard (A) rates, but requires a 
different sorting system.    If you regularly send standard (A) bulk mail that exceeds flat-sized dimensions, 
we will be happy to provide you a quote for a special version of Postage $aver to meet your needs.

Weight/Piece (oz.): 

If your mail exceeds a specified weight (which varies depending on what type of mail you are sending), 
your postage will include a per-pound surcharge. For flat-sized mail, the weight of each piece can also 
determine the minimum number of pieces to be placed in each sack. 

You must upgrade to Postage $aver Pro to sort either of the following types of mail:
 Mail that is subject to the per-pound surcharge
 Flat-sized pieces weighing more than 1.92 ounces.

When you select a type of mailing, Postage $aver determines what weight level applies. The top button 
on the Wt./Pc selector should be chosen if your mail is less than or equal to the weight shown next to the 
button. If you mail is heavier than the weight shown next to the top button, enter the correct weight in 
ounces in the box next to the bottom button. (You do not need to enter an exact weight in the bottom box 
if you have selected the top button.)

Note that all weights are in ounces.

All standard (A) bulk mail is limited to a maximum of 16 ounces per piece. Some types of standard (A) 
bulk mail are limited to much lower weights.    First-class automated mail is limited to a maximum of 
3.3407 ounces. Postage $aver will not let you enter a weight above the limit for the type of mail you have 
selected.

Maximum Pieces in a Full Tray:

Mail that is prepared in trays can often only be submitted in full trays at certain sorting levels.    To know 
when a tray is "full", Postage $aver must know how many pieces of your mail it takes to fill a tray. 

If your mailing is prepared in trays, you must enter the maximum number of pieces that fit in one tray in 
the indicated space. Postage $aver will create "full" trays that have at least 75% of the maximum number 
of pieces you specify, but not more than the number you specify, in accordance with USPS regulations.

Submission of trays that are less than 75% full where only full trays are allowed can result in rejection of 
your mailing by the USPS.

Tray Type:



Letter-sized mail that is prepared in trays must generally be prepared in standard "mm" trays, which come 
in 1' and 2' lengths. If you check "mm", Postage $aver will properly sort your mail to 1' or 2' trays as 
appropriate. If your mail is less than 4 5/8" high and 10" wide, you must use mm trays, and you should 
check the "mm" button. If your mail is larger than either of those dimensions, you must use emm trays 
and you should check the "emm" button.

OK: Click this or hit enter to save your entries.

Cancel: Click this to restore the entries you previously saved.



Mailer Location Settings

These settings determine what "entry point" postage discounts apply to your mailings. They also can 
affect how your mailing list is sorted, so they must be set correctly for your mail to be accepted by the 
post office. Entry point discounts are discounts based on how many times your mail must move from one 
sorting facility to another.    You pay less postage for those pieces in your mailing that remain within the 
territory served by sorting facility where they are mailed.

Mailer's Home Post Office: 

This should be the post office where you have your bulk rate permit.

City:    Fill in your home post office's city, using all caps.

State: Fill in the two-letter postal abbreviation for your home post office's state, using all caps.

Zip:    Fill in the five-digit zip code of the post office where you have your permit.    This zip code is used to 
determine what post offices you can use to earn "entry discounts" for your mail. (Use only a five digit zip 
code here, not a nine-digit code.) 

Mailings will be sent from: 

Indicate where you will deposit your mailing.    Mailings sent from postal sorting facilities earn substantial 
postage discounts.    Postage $aver automatically chooses the appropriate sorting facilities for the zip 
code you enter above, and computes applicable mail entry discounts based on your selection. If you don't 
know which button to set, ask the supervisor at the post office where you drop your bulk mail.

Mail submitted at your designated bulk mail center will earn entry discounts for those pieces addressed 
throughout your entire state, or a large part of your state. Mail submitted at your area's sectional center 
facility will earn larger entry discounts, but those discounts will only apply to mail addressed to your 
immediate area.    If your bulk mail center is nearby, you might want to run Postage $aver twice, once 
choosing the bulk mail center and once choosing the sectional center facility, to see which results in lower 
postage.

Postage $aver automatically applies entry discounts to the correct pieces in each mailing, so that your 
postage is always calculated correctly.

Company name:

This is the mailer name that will be printed on the USPS Qualification Report.

Mail ID number (if used):

The USPS Qualification Report provides a space to enter a mail ID number for use by the mailer to 
identify the mailing.    The text entered in this box will be printed as the mail ID number on the Qualification 
Report.

OK: Click this or hit enter to save your entries.



Cancel: Click this to restore the entries you previously saved.



Preference Settings; Creating Sorting Files and Endorsement Lines

These settings determine whether and how Postage $aver creates sorting files that many data base 
programs can use to sort your mailing list.

Print "Rejected Zips" report: 

The "Rejected Zips" report is a listing all invalid zip codes that Postage $aver finds.        If this box is 
checked, the "Rejected Zips" listings will be included in the sort report. Normally, you should leave this 
box checked.

The "Rejected Zips" report is printed when you choose the "verify" option on the Sort menu regardless of 
whether or not this box is checked.

Save file of sort keys and endorsement lines: 

When this box is checked, Postage $aver will create a special sorting file for each mailing list you sort. 
The sorting file is used to provide sorting information and endorsement lines back to your data base. 
(Endorsement lines are the lines you can use on your address labels to avoid using sticky red dots on 
your mail.    For example, *******5D 77005 can be printed on the address labels for all pieces that are 
being packaged together for zip code 77005.)

The sorting file is either an ascii comma-delimited file or an ascii tab-delimited file, depending of the 
setting of the "Format of saved file" buttons below. The data in each record of the file is in the following 
order:
Sack or Tray number
Package or Group number
Zip code number
Endorsement line.

The records in the sorting file are in the same order as the records in your mailing list file, so the sorting 
file can be directly read back into your data base using the data base's "import" function. Once the sorting 
numbers are back in your data base, you can sort your mailing list so that labels will be printed in the 
same order as Postage $aver's Bulk Mail Sort Report. Use the tray number as the "primary" or first level 
of the sort, followed by the package number, followed by the zip code number. (Rejected pieces will be at 
the end of the list.)

If you use Postage $aver to sort several mailing lists at once, there will be a sorting file created for each 
mailing list, so that you can read each sorting file back into its corresponding data base without needing 
to separate the sorting files manually.

To use the endorsement line, place it as the very top line of each address (unless you are using a 
barcode as the top address line, in which case the endorsement line should go directly under the 
barcode). The right edge of the endorsement line must be on the right margin of the address, and, if 
possible, all blank space on the line should be filled with asterisks. If you properly include the 
endorsement line with each address, you are not required to use USPS stickers to identify each package 
of mail.

Note that the endorsement line for a given address can change depending on how your mail is sorted, so, 
if you are using endorsement lines, you must create new endorsement lines for each mailing.    Postal 
barcodes, on the other hand, stay the same regardless of how the mail is sorted, as long as the address 
and nine-digit zip code do not change.



Use standard file names:

This box determines what each sorting file created by Postage $aver will be named. If you do not check 
this box, Postage $aver will stop and ask you for a file name for each sorting file it creates. If you do not 
want to have to bother supplying these names, or if you want to create a script or macro in your data base 
program that looks for the same file name every time, then check this box. 

If this box is checked, the sorting file created when you sort a single mailing list file will be named 
"P$sort1.txt". If you sort two mailing lists together, the sorting file for the first mailing list will be named 
"P$sort1.txt", while the file for the second mailing list will be named "P$sort2.txt", and so on for additional 
data bases. Files using the standard file names will be placed in the same directory as Postage $aver.

Output file format:

These buttons choose the format of the sorting files. If you have selected "Save file of sort keys and 
endorsement lines" above, you should choose a format that your data base can read. This setting does 
not affect the type of mailing list file that Postage $aver can read.



Sorting and Verifying Mailing Lists

Choose the Sort menu to create sorting instructions and sorting files and to check for bad zip codes, 
states and cities.

Preparing your mailing list for sorting by Postage $aver:

For Postage $aver to be able to read your mailing list, your data base program must store the list in one 
of several standard formats: 

 tab-separated ascii text
 comma-separated ascii text
 merge (comma-separated text with a header record)
 dBase (.dbf)

If your data base does not automatically store its files in one of these formats, there is still a good chance 
that you can prepare files for Postage $aver by using your data base's "export" or "save as" command. 
One of those two commands should give you a list of possible formats for saving your mailing list.

If you do not want to mail to all of the names on your mailing list, be sure to select only those names to 
which you will be mailing before exporting the file.

Your mailing list is composed of various "fields", such as "first name", "address", etc.    Postage $aver 
needs only five-digit zip codes to properly sort your mailing list, so the zip code field is the only field that 
you absolutely have to have in the file you export or save for Postage $aver. The zip code must be in one 
of the following formats:

 12345 (five-digit zip code)
 12345-6789 (nine-digit zip code)
 123456789 (nine-digit zip code without hyphen)

If you have enough mail going to a single zip code to require a tray or sack for that single zip code, 
Postage $aver will need to know the city and state for that zip code in order to create a correct tray or 
sack label. Postage $aver will accept alpha fields for city and state, as well as a    combined city and state 
field, in the format: city, ST

Sorting a single mailing list:

To sort a single mailing list, choose "Sort One List" from Postage $aver's Sort menu. Then, select the file 
you have exported or saved from your data base.

Postage $aver will identify the format of the file, compute the total number of records in the file, and read 
the first record. Postage $aver will try to determine which fields are the zip code, state and city fields (if 
provided). 

Postage $aver shows which fields it has identified by displaying the name of the field next to the 
corresponding information from the file. For tab-separated and comma-separated ascii text files, Postage 
$aver will show you this information for the first record. For merge files, Postage $aver will show you a list 
of field names from the file. Fields that are not found or identified by Postage $aver are shown next to the 
designation "field not found."

You can view any record in your file to make sure that the fields have been properly identified. Use the 



"prev" and "next" buttons in the record viewer to move through the file. (For merge files, the field list 
appears as a record immediately before the first data record in your file.)

If the information displayed is correct, click OK. If it is incorrect, you can move the field name to line up 
with the proper data item by double-clicking on the field name you need to move, then clicking in the box 
in which it should appear. (If there is already a field name in the box, you must first move it to an empty 
box.)

Once you press OK, Postage $aver will read and sort the file, using the mail type settings and mailer 
location settings you have entered under the Settings menu.

Postage $aver will then prepare the Bulk Mail Sort Report, and display your printer's print dialog so that 
you can print or view the report.

If you have selected "Save file of sort keys and endorsement lines" in the Preferences window, Postage 
$aver will next save those files.    See "Preferences Settings and Creating Sorting Files" on the Help 
menu.

Sorting more than one mailing list:

To sort more than one mailing list at the same time, choose "Sort Several Lists" from the Sort menu. The 
procedure is almost the same as that for sorting a single list, except that after reading each file, Postage 
$aver will ask whether you want to load another file or begin sorting. You can also cancel the job at this 
point.

Once you being sorting, the process is identical, except that if you are saving sorting files, there will be a 
separate sorting file saved for each list Postage $aver has read.

Verifying lists without sorting: 

You can use Postage $aver to check for bad zip codes and mismatched states and/or cities without 
actually sorting the list. To verify a single list, choose "Verify Without Sorting" from the Sort menu. To 
verify several lists at the same time, choose "Verify Several Lists" from the Sort menu.

Postage $aver follows the same steps for verifying as for sorting, except that the sorting will not occur. 
The report produced will only include a listing of rejected zip codes. No sorting files will be saved. 

Verifying without sorting is particularly useful for cleaning up your mailing list files before actually sorting 
for bulk mailing.



Tray/Sack Labels; Qualification Report; Reprinting; Setting Label Fonts

Printing Tray and Sack Labels:

Postage $aver prints barcoded tray and sack labels according to postal service specifications. After 
sorting your mailing list, you can print sheets of labels for the trays or sacks by choosing the "Print Tray 
and Sack Labels" from the File Menu. (Barcodes are NOT currently required on tray and sack labels for 
non-barcoded mail. However, the postal service says it expects to implement this requirement for ALL 
bulk mail by late 1997.)

Tray labels are formatted to fit standard business card printer paper, such as Avery 5371 (for laser 
printers) or Avery 8371 (for ink jet printers).    Each sheet contains two columns of five cards, with 1/2-inch 
margins at the top and bottom and 3/4-inch margins on the left and right. Sack labels are formatted to be 
printed on the same forms but will require trimming to their proper size.

Note that the labels will NOT be correct if you have changed any of the "Settings" screens since 
you originally sorted the mailing list with Postage $aver.

Not all printers can print tray and sack label barcodes to postal specifications. We recommend that you 
consult your local postal bulk mail center supervisor to be sure that the labels printed by your printer meet 
specifications.

Printing the Qualification Report:

The USPS Qualification Report is used by your post office to verify that your mail qualifies for the rates 
you have indicated on your mailing statement. It is not required for the types of mailings that Postage 
$aver can sort. However, submitting this report with your mailing can speed the initial handling of your 
mail and can avoid problems with a postal clerk who may not be aware that the report is not mandatory 
for all types of mailings.

Note that the Qualification Report will NOT be correct if you have changed any of the "Settings" 
screens since you originally sorted the mailing list with Postage $aver.

Reprinting the Sort Report:

You can reprint your last Bulk Mail Sort Report by choosing "Reprint Last Sort Report" from the File menu. 
Only sort reports are saved for reprinting. Verification reports cannot be reprinted.

Note that the report will NOT be correct if you have changed any of the "Settings" screens since 
you originally created the report with Postage $aver.

Setting Label Fonts:

The postal service has very specific regulations regarding the size and style of the printing on each line of 
barcoded tray and sack labels. Postage $aver has been designed to use particular fonts and specific 
sizes in order to comply with these regulations. (Postage $aver uses Monaco on Macintosh systems, and 
Arial on Windows systems.) However, since fonts vary from system to system, the "Set Label Fonts" 
screen on the Settings menu allows you to change the fonts and their sizes.

The screen shows drawings of a tray label and a sack label. For the tray label, three different type sizes 
are required: one above the barcode, one in the upper right corner, and one below the barcode. You can 



enter each of these three sizes separately in the spaces provided on the drawing.    The sack label 
similarly shows two sizes, one for the text to the immediate right of the barcode and one for the text that is 
right-justified on the label.

We do not recommend that you change fonts or font sizes unless either we or postal authorities 
instruct you to do so. If you change the font or any of the sizes, you should check with your local 
postal bulk mail center to make sure your labels still comply with postal service requirements. 
Failure to meet labeling requirements can cause your entire mailing to be rejected.



Adding or Removing Pieces From a Mailing After Running Postage $aver

Sometimes when you are preparing a mailing, you may notice duplicates or incorrect pieces that you 
might want to delete without re-running your entire Postage $aver report.    Or, you might want to add a 
piece or two.

You can do this as long as you take the following items into account:

1.)    You can delete pieces from any package, tray or sack as long as the number of pieces in the 
package does not fall below any minimum number of pieces for the type of mailing you are preparing. 

2.) You can add pieces to any package, sack or tray as long as the number of pieces sorted to any 
specific zip code, 3-digit area, adc area, etc. does not increase to more than the minimum amount 
required for a new package, sack or tray for the type of mailing you are preparing.

Be sure to subtract or add such pieces from or to the total piece count on the front page of the sort report. 
Also, be sure to subtract or add such pieces from or to the appropriate rate category on the front page of 
the sort report. 

Generally, all pieces in a single sack or tray of mail are in the same rate category. The discount categories 
for each sack or tray are listed on the sort report next to the sack or tray label. 

Exception: The presort discount for each piece of barcoded flat-sized mail is determined by the package 
the piece is in, rather than by the sack it is in. A sack that contains pieces in more than one presort 
category will be designated by a presort discount of "mixed" on the sort report. You can print the 
Qualification Report to see the discount category for each package in an automated flats mailing.



Changing or Printing the Postage Rate Charts

Postage $aver uses two sets of postage rate charts to calculate the postage charges for your mailing. 
One set of charts is for "regular" mailers (including the first-class rate chart), the other for approved 
nonprofit mailers. The information on these charts can be changed or printed by choosing the appropriate 
option on the Rates menu.

Note: Postage $aver determines which charts to use for your mailings by the setting of the Rate Category 
buttons on the Mail Type screen. See "Mail Type Settings" on the Help menu for more information.

Choosing "Regular Rates" or "Nonprofit Rates" from the Rates menu will each bring up several    charts in 
sequence.    Each rate chart has categories appropriate to the type of mail covered by the chart. Rates 
can be updated by clicking on the rate you need to change and typing the correct value. Click OK to save 
the new rates, or Cancel to restore the original data.

Choose "Print Rate Charts" to print all seven postage rate charts.



Changing or Printing the USPS Sorting Lists

The Postal Lists menu lets you view, edit and print the basic postal sorting lists that Postage $aver uses 
to create and label packages and sacks. These lists are created from information in the USPS Domestic 
Mail Manual. Making changes to these lists without proper care could result in incorrect sorting 
and labeling, leading to rejection of your bulk mailings by the USPS.

Edit Postal Lists:

This selection allows you to manually edit the individual sack label lists and the corresponding three-digit 
zip code lists for each sorting level. Choosing one of the lists will bring up a window showing the first sack 
label on the list.    (Some labels require entries on two lines, with the entry on the second line split into a 
left-justified section and a right-justified section, which will be indicated visually in the window.)

To move through the list, use the "next" and "prev" buttons. (Clicking prev from the first label will take you 
to the last label on the list, and clicking next from the last label will take you to the first label.)

To edit a label, make the changes you want to make and then click Save. You will then see a list of the 
three-digit zip code areas for that label. Add or delete any areas as necessary, then click "OK". Your 
changes will be recorded.

To change the three-digit zip code areas without editing the label, press "OK" from the screen that 
displays the label, without making any changes to the label.

If you are editing the zip code areas list for 3-digit Labels, the screen will have an additional box labeled 
"Unique City Zips". This box is for designating three-digit zip code areas on the USPS "Unique cities" list. 
If a three-digit zip area in the upper box is also on the unique cities list, it should also be listed in the 
Unique City Zips box.

If you are editing the state exceptions list, the exception zip code is listed on the second line of the label, 
rather than in a separate window.

Print Postal Lists: 

This option lets you print any of the sack label lists along with the corresponding three-digit zip code 
areas for each label.



Using Postage $aver with Filemaker Pro

Filemaker Pro encodes the data it stores, and, as such, its files cannot be read directly by Postage $aver. 
However, it is easy to send files from Filemaker Pro to Postage $aver and back again.

Creating the file for Postage $aver to sort:

To prepare a Filemaker Pro file to be read by Postage $aver:
 FIND the records you want to include in your mailing. 
 EXPORT the records to a new file, using the Import/Export command from the File menu. 
* Choose "tab-separated" as your export file type. 
* When the list of fields is displayed, be sure to put a check mark next to your zip code field, and next to 
your state and city fields (or your combined city and state field if you keep your city and state in a single 
field) if you choose to use Postage $aver to check your state and city data.    No other fields should be 
checked.    The order of the fields does not matter.
* Choose "Don't format output."
* Click OK to export the file.

Now you can run Postage $aver using the file that Filemaker Pro exported.

Sorting your Filemaker Pro file in tray/package order, and adding endorsement lines to your 
labels:

If you want to be able to sort your Filemaker Pro file in the same order as Postage $aver's Bulk Mail Sort 
Report, you will need to DEFINE three new sorting fields in your Filemaker Pro file as follows:
Name: Tray Number                    Type: Number
Name: Package Number          Type: Number
Name: Zip Number                          Type: Number

To add endorsement lines to your labels, you will need to DEFINE a field to hold the endorsement line, as 
follows:
Name: Endorsement Line        Type: Text

 In Postage $aver, make sure you have checked "Save file of sort keys and endorsement lines." and "Use 
standard file names" on the Preferences window on the Settings menu. (The file format chosen does not 
matter.)
 Use Postage $aver to sort the file that you exported from Filemaker Pro.
 Without changing the group of found records you used when exporting your file, choose IMPORT 
records, using the Import/Export command from the File menu in Filemaker Pro.
* Choose the P$sort1.txt file to import. You'll find it in the same directory as Postage $aver.
* When the list of fields is displayed, choose "Replace data in current found set".
* Align your sorting fields and the Endorsement Line field with the fields in the P$sort.1.txt file.    The fields 
in the P$Sort1.txt file are in the following order: Tray Number, Package Number, Zip Number, 
Endorsement Line.
* Click OK to import the file.
 SORT your found records, in ascending order, by Tray Number, Package Number and Zip Number. They 
will now be in the same order as on Postage $aver's sorting report.

Filemaker Pro is a trademark of Claris Corporation.





How to Reach Us; Update Policy:

How to reach us:

Via E-Mail: scott@scotthochberg.com

By Phone:    713-669-9919.    If you leave a message, please indicate that you are a registered user, the 
nature of your question, and when we can reach you if we are not immediately available. Telephone 
support is NOT available to unregistered users.

By Mail:    7505 Brompton, Houston, TX    77025

Update policy:

We will provide any bug fixes and updates based on new postal regulations at no charge within one year 
of your registration date.    We normally provide these updates via e-mail.    If you paid an additional fee for 
updates via regular mail, we will mail them to you. We may also notify you by e-mail, if we have your 
address, to speed your receipt of any new information.

We learn of changes to bulk mail requirements through the Domestic Mail Manual and other official USPS 
sources.    We are not obligated to notify you of any change that is not announced via a revision to the 
Domestic Mail Manual, although we may notify you of changes prior to such revision.

It is your responsibility to send us any changes to e-mail or regular mail addresses.    We will discontinue 
e-mail notifications if your e-mail is returned "addressee unknown".    We will discontinue regular mail 
notifications if your regular mail is returned without a forwarding address.

We are not responsible for updating Postage $aver if the USPS makes major changes in the bulk mail 
system that would, in our judgment, make your Postage $aver version substantially useless for standard 
(A) bulk mail.



Registering your software

When you register, you receive:

 updated files for a full year when the USPS changes sorting requirements or rates;
 free bug fixes for a year as necessary;
 full technical support via e-mail and telephone;
 a clear conscience.

Plus, you can upgrade your copy of Postage $aver to Postage $aver Pro, so you can sort your mail to 
take advantage of the barcoding discounts.

Registration of Postage $aver Lite costs only $20!    Or, you can upgrade to Postage $aver Pro for only 
$45.

There are NO shipping or handling charges if you give us an e-mail address where we can send you 
update files.    We will add a $10 shipping and handling charge if you request updates via regular mail.

You can register in the following ways:

1.) If you are a CompuServe member, GO SWREG on Compuserve to register automatically.    Your 
registration fee will be added to your CompuServe bill. We will be notified of your registration within about 
24 hours and will send you your registration number promptly.
Register using CompuServe product number: 
11946 for Postage $aver Lite    ($20)
11947 for Postage $aver Pro    ($45)

2.) To register using VISA, Master Card, or Discover, go to our web site at 
http://www.scotthochberg.com/postage.html
OR
print the Registration Form on the next page and send it to one of the addresses shown, or call NorthStar 
Solutions at 800-699-6395, 10am-8pm (EST) Mon-Sat, for faster service

Please note that NorthStar Solutions does not know anything about Postage $aver other than how 
to collect credit card charges for us. Please don't trouble them with technical or other questions. 
For tech support and customer service, please call 713-669-9919 or e-mail us at 
scott@scotthochberg.com.

3.) To register by check, print the Registration Form on the next page and send it with your payment to:

L. Scott Hochberg Consulting Services
7505 Brompton
Houston, TX    77025-2266

Your check should be in the amount of:
$20 to register Postage $aver Lite, with updates via e-mail.
$45 to upgrade automatically to Postage $aver Pro, with updates via e-mail.

Add $10 for updates via regular mail, only if you cannot receive e-mail updates.
(Texas residents add 8.25% sales tax to the total amount.)

Thank you for registering!



Postage $aver Order Form

Your Name:

Company Name:

Address Line 1:

Address Line 2:

City, State and Zip:

Daytime Telephone:

E-Mail Address:

Where did you hear about Postage $aver?:

____ I have Postage $aver version ______. Register my copy and send updates.

____ I do not yet have Postage $aver. Send me a registered copy. 

____ copies Postage $aver Lite for Mac                    $20.00 ________

____ copies Postage $aver Lite for Windows    $20.00 ________

____ copies Postage $aver Pro for Mac                    $45.00 ________

____ copies Postage $aver Pro for Windows    $45.00 ________

____  shipping per address                                                                  $10.00                           ________
(Do not add shipping charges if you want updates via e-mail)

Subtotal:                                                                                                         ________

Texas residents add 8.25% sales tax                                                                      ________

Total:                         
________

FOR PAYMENT BY CHECK, mail to: 
L. Scott Hochberg Consulting Services, 7505 Brompton, Houston, TX    77025.

FOR TECH SUPPORT OR CUSTOMER SERVICE:
Phone: 713-669-9919    -or-    E-mail: scott@scotthochberg.com

***********************************************************************
FOR CREDIT CARD ORDERS (Visa, Master Card, Discover):

Visit our web site at http://www.scotthochberg.com/postage.html



or 

Contact: NorthStar Solutions: 
(This is an order processing service only
 - no technical info at NorthStar Solutions.)
FAX: 803-699-5465 
PHONE: 800-699-6395 (10am-8pm, EST, Mon-Sat) 
E-MAIL: StarMail@compuserve.com or Starmail@aol.com 
MAIL to: 

NorthStar Solutions
P. O. Box 25262
Columbia, SC    29224

Credit card #: _________________________________ Exp Date: ______

Name and address on card, if different from above:

Signature:___________________________________________

Thank you for your order!




